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BOWDOIN COLLEGE 
Brunswick, Maine  

 
REQUIREMENTS FOR SUBMISSION OF HONORS PROJECTS  

TO THE COLLEGE ARCHIVES, SPRING 2009 
 

 
 
INTRODUCTION 
 
“The honors project offers seniors the opportunity to engage in original work under the 
supervision of a faculty member in their major department or program.  It allows qualified 
seniors to build a bridge from their coursework to advanced scholarship in their field of study 
through original, substantial, and sustained independent research. The honors project can be the 
culmination of a student's academic experience at Bowdoin and offers an unparalleled chance 
for intellectual and personal development.” 
      Bowdoin College Catalogue for 2008-2009 
 
After an honors project is accepted by an academic department, the final requirement for a 
student to graduate with honors is the submission of the project to the Bowdoin College Library. 
All approved honors projects are retained permanently in the College Archives.   
 
The following guidelines have been established to assist students in preparing honors projects 
and submitting them to the Library.  You are encouraged to consult with librarians at any time 
for assistance with your research, writing, and preparation of your project.  All honors projects 
must be submitted in person to the Librarian of the College, Sherrie Bergman, no later than 
Friday, May 15, 2009, at 5:00 p.m. 
 
 
Final acceptance of honors projects by the Library is subject to fulfillment of 
the technical and stylistic requirements outlined in this document. 
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RECOMMENDED STYLE MANUALS 
 
Different academic disciplines may follow different stylistic conventions for scholarly papers.  
The formatting of footnotes, endnotes, and lists of references, and the arrangement of the text all 
should follow the style recommended by your discipline.  The following style manuals are a few 
examples of guides that you may be expected to follow; or you may use the Turabian manual for 
most disciplines.  Please consult with your advisor or department Chair.  All manuals are 
available at the Bowdoin Library or for purchase at the Bowdoin Bookstore.  Online versions of 
style manuals usually are abridged; it’s a good idea to invest in a print copy for your referral. 
 
Please note that some conventions for articles to be published in a journal do not necessarily 
translate to an academic thesis; e.g., a running title on every page may be required for 
publication, but it’s not appropriate for your honors project. 
 
Multidisciplinary: 
 
A Manual for Writers of Research Papers, Theses, and Dissertations: Chicago Style for 
Students and Researchers.  Kate L. Turabian.  7th ed.  University of Chicago Press, 2007.  
  Main Library Reserve 132 
  Main Ref Desk; Science Ref; Art Ref.  LB2369 .T8 2007 
 
The Turabian manual is recognized by vote of the Faculty as the College style manual. The 
instructions outlined in Turabian should be followed unless your department recommends 
another manual.    
 
The Chicago Manual of Style. 15th ed.   University of Chicago Press, 2003 [an online version of 
the complete Chicago Manual of Style is available through the Library Catalog] 
  Main Libr Reserve  130a          
  Main Ref  Desk; Spec Coll Ref   Z253 .U69 2003      
 
Humanities: 
 
MLA Handbook for Writers of Research Papers. Joseph Gibaldi.  6th ed. Modern Language 
Association of America, 2003.  
  Main Libr Reserve 135    
  Main Ref;  Science Ref LB2369 .G53 2003 
 
Social Sciences: 
 
Publication Manual of the American Psychological Association.  5TH ed.  American 
Psychological Association, c2001 
  Main Libr Reserve 130b 
  Main Ref Desk; Science Ref BF76.7 P83 2001 
 
Or: Pocket Guide to APA Style.  2nd ed., Robert Perrin.  Houghton Mifflin, 2007 
  Main Ref Desk BF 76.7 P47 2007 
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Sciences: 
 
Scientific Style and Format: the CSE Manual for Authors, Editors, and Publishers.  Style 
Manual Committee, Council of Science Editors. 7th ed.   Council of Science Editors in 
cooperation with the Rockefeller University Press, 2006 
   Science Ref  T11 .S386 2006  
 
Electronic Sources: 
 
The Columbia Guide to Online Style.  Janice R. Walker and Todd Taylor. 2nd ed.  Columbia 
University Press, 2006 
 Main Library Reserve 129 
 Main Ref Desk; Science Ref PN171 F56 W35 2006 
 
See also the Library’s Citation & Style Guides page 
http://library.bowdoin.edu/eref/write.shtml for online versions of style manuals.
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FORMAT REQUIREMENTS FOR ALL HONORS PROJECTS 
 REGARDLESS OF STYLE MANUAL USED 

   
Acid-Free Paper: 
 
To ensure the longevity of the manuscript, all theses must be printed on 8½ x 11 inch 20-pound 
acid-free paper that meets Standard #Z3948 of the American National Standards Institute 
(ANSI).  The College Bookstore carries two brands of acceptable paper:  Crane Thesis Paper, 
Item #BT816S, and Perma/Dur Archival Buffered Bond Sheets.   No other paper will be 
accepted for the Library archival copy unless it can be demonstrated to meet ANSI #Z3948.   
The College Archives on the third floor, H-L Library, can test paper samples to determine 
whether or not particular stock conforms to the standard. 
 
Title Page Format (see sample attached): 
 
Title: 
 
The title should be centered between the right and left margins, four inches below the top of the 
sheet (three inches below the upper margin).  Use capital and lower case letters with no end 
punctuation. If the title requires more than one line, double space the subsequent line(s) and 
begin each with a capital letter whether or not one might otherwise do so.   
 
Department Statement: 
 
Five lines below the final line of the title, center the statement: 
 
An Honors Paper [or Project] for the Department [or Program] of [department name]. 
 
Author’s Name: 
 
Two lines beneath the Department Statement, centered, is the by-line, with the author's name 
in the same form as in other official College records.  Please consult with the College 
Registrar if you need to verify the form of your name that appears in College records.   
 

By Your Full Name 
 

Imprint and Copyright Statement: 
 
Beginning three lines above the bottom margin, centered, and without a period, are the imprint 
statement and the copyright statement, separated by one line.  The copyright statement should 
include the copyright symbol [] or the term “Copyright” followed by the year and the author’s 
full name.  The “Copyright” line should rest at the bottom margin, one inch above the bottom 
edge of the page. 
 

Bowdoin College, 2009 
 

 2009 Your Full Name 



 5 
 

Important Information about Department and Program Names:   
 
Please note carefully the official names of College departments and programs as listed in the 
attached chart from the Registrar.  The official name(s) must appear correctly on the title page. 
Some examples are shown below: 
 
An Honors Paper [or Project] for 
 
 the Department of Romance Languages  [official department name] 
 
 the Program of Asian Studies  [official program name] 
 
 the Departments of Economics and Sociology and Anthropology   [interdisciplinary 
 major] 
 
 the Program of Environmental Studies and the Department of Philosophy  [program that 
 also involves a particular department] 
 
 the Faculty Sponsors from the Departments of Art and Music  [student-designed major 
 not affiliated with a particular department] 
 
Font Style and Size: 
 
Select a font that is easy to read.  “Times Roman,”  “Garamond” and “Univers” are examples of 
established fonts that read well; avoid styles that attempt to mimic cursive.  The font size for the 
main body of text should be 12-point; captions, titles and other headers may fluctuate relatively 
but should not be overly large, nor should any type be smaller than 10-point.  All equations and 
formulas should be printed rather than handwritten. 
 
Printing: 
 
All submissions must be prepared using a letter-quality printer. Photocopies are 
unacceptable.  All printing should be in black or grayscale whenever possible; color inks and 
dyes lack permanence and should be avoided.   
 
If colored graphs, tables, or other illustrations must be included within the text for the sake of 
clarity, do one of the following: 
 

• Make additional copies of the color images reprinted in grayscale and insert them as an 
Appendix; or 

• Submit digital copies of the color images in TIFF format, on a “gold standard” CD-R; or 
• Use an Epson 2000 series (or higher) printer and archival paper—the ink cartridges used 

in that series of printers are pigment-based and provide acceptable color stability over 
time.  
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FORMATTING & PAGE NUMBERING: SINGLE-SIDED PRINTING 

 
Margins: 
 

• Left margin should measure 1.5 inches to allow for binding; the upper, lower and right 
margins should measure 1 inch. 

 
General Guidelines: 
 

• Be consistent about placement of page numbers, and place them no nearer than 0.5” from 
the edge of the sheet of paper. 

• Include a blank sheet of acid-free thesis paper at the beginning and at the end of your 
submission. 

• Some pages (such as title page) should not show any numbers, but they ARE counted in 
the numbering sequence. 

• Include a page number unless otherwise indicated below. 
• The order of sections listed below is the order recommended by Turabian. 

 
Sections of the Thesis: 
 
1.   Front Matter (preliminary pages):  use lower-case Roman numerals (i, ii, iii, iv, etc.) in 

this order: 
 

• Honors Project Completion Form (required; use attached acid-free form) uncounted 
and unnumbered 

• Copying Permission Form (required; use attached acid-free form) uncounted and 
unnumbered 

• Title Page (required): counts as page i, but the number is not printed on the page. 
• Dedication; Epigraph (both optional): these count in sequence of Roman numerals, but 

the number is not printed on the page.  These are not listed in the Table of Contents. 
• Table of Contents (required for all papers divided into chapters; recommended for 

all): counts as page ii if directly following the Title Page, or a higher number if there’s a 
dedication or epigraph.   

• List of Figures, Tables, or Illustrations (optional, but recommended if appropriate): 
counts as Roman numeral page in sequence after Table of Contents, and should be the 
first thing listed in the Table of Contents. 

• Preface; Acknowledgments; Abstract (all optional):  should be listed in Table of 
Contents and numbered in Roman numbering sequence, after the Table of Contents & 
Lists of Figures. 

 
 
 
 
 
 

 
2.   Text:  Includes everything between the front matter and the back matter; numbered 
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with Arabic numerals. 
 

• Introduction (optional): if included, this is page 1. 
• Chapters or Sections:  if no Introduction, Chapter 1 would be page 1.  Begin each new 

chapter on a new page.  Continue sequence of Arabic numbering. 
 
3.   Back Matter: continues numbering with Arabic numerals. 
 

• Illustrations (optional) 
• Appendixes (optional): this is where you could put black & white copies of color images 

from the body of the text. 
• Endnotes, Bibliography, or Reference List (required in most papers): One of these lists 

will be the final section of the paper. 
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FORMATTING & PAGE NUMBERING: DOUBLE-SIDED PRINTING 
 
Special Considerations for Double-Sided Printing: 
 

• To ensure that text and images do not “bleed through” the paper, high-quality acid-free 
paper is required.   Please use Perma/Dur or Crane’s, sold at the College Bookstore. 

• Precision laser printing must be used to avoid “bleed through.” 
• The Librarian will make the final decision on accepting a thesis with double-sided 

printing.  It is strongly recommended that you test-print several pages, especially those 
displaying pictorial or other non-text material, and ask the Librarian to determine if they 
are acceptable. 

 
Margins 
 

• Margins must be set to permit both odd and even pages to have a “gutter” for binding.  
MS Word allows for automatic page formatting for double-sided printing.  Under 
File>Page Setup>Margins, select the following settings:   

• All margins = 1 inch; gutter = .5 inch; next to “Multiple Pages”, select “Mirror Margins” 
from the drop-down menu.  These settings will result in the inner margin of both left and 
right pages measuring 1.5 inches to allow for binding; the outside margins will measure 1 
inch. 

 
General Guidelines: 
 

• Be consistent about placement of page numbers, and place them no nearer than 0.5” from 
the edge of the sheet of paper. 

• Include a blank sheet of acid-free thesis paper at the beginning and at the end of your 
submission. 

• Some pages (such as title page) should not show any numbers, but they ARE counted in 
the numbering sequence. 

• The backs of pages such as the Title Page count in the numbering sequence, even if they 
don’t show the number. 

• All new sections or chapters should begin on the next consecutive odd-numbered (right-
hand) page, whether Roman or Arabic numerals. 

• Include a page number unless otherwise indicated below. 
• The order of sections listed below is the order recommended by Turabian. 

 
Sections of the Thesis: 

 
1.   Front Matter (preliminary pages):  use lower-case Roman numerals (i, ii, iii, iv, etc.) in 

this order: 
 

• Honors Project Completion Form (required; use attached acid-free form) uncounted 
and unnumbered 

• Copying Permission Form (required; use attached acid-free form) uncounted and 
unnumbered 
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• Title Page (required): counts as page i, but the number is not printed on the page.  The 
back of the Title Page counts as page ii; the number is not printed.  

• Dedication; Epigraph (both optional): would count in sequence of Roman numerals, but 
the number is not printed on the page 

• Table of Contents (required for all papers divided into chapters; recommended for 
all): counts as page iii if directly following the Title Page, or a higher number if there’s a 
dedication or epigraph.  The back of the Table of Contents counts as page iv; if the page 
is blank, the number is not printed. 

• List of Figures, Tables, or Illustrations (optional, but recommended if appropriate): 
counts as Roman numeral page in sequence after Table of Contents, and should be the 
first thing listed in the Table of Contents. 

• Preface; Acknowledgments; Abstract (all optional):  should be listed in Table of 
Contents and numbered in Roman numbering sequence, after the Table of Contents & 
Lists of Figures. 

 
2.   Text:  Includes everything between the front matter and the back matter.  Numbered 

with Arabic numerals. 
 

• Introduction (optional): if included, this is page 1. 
• Chapters or Sections:  if no Introduction, Chapter 1 would be page 1.  Begin each new 

chapter on the next consecutive odd-numbered page (right side when book is open).  
Continue sequence of Arabic numbering. 

 
3.   Back Matter: continues numbering with Arabic numerals. 
 

• Illustrations (optional) 
• Appendixes (optional): this is where you could put black & white copies of color images 

from the body of the text. 
• Endnotes, Bibliography, or Reference List: (required in most papers) One of these lists 

will be the final section of the paper. 
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FORMATTING & PAGE NUMBERING: SWITCHING FROM 
 ROMAN TO ARABIC PAGE NUMBERS 

 
To switch from Roman to Arabic page numbers in your document:  
 
Roman Numerals in Front Matter, start with cursor on the Title Page. 

• On the Insert menu, click Page Numbers.  
• Remove Check from Show Number on First Page 
• Click Format.  
• Choose Number Format:  i,ii,iii 
• In the Start at box, enter i.  

 
Insert a section break where you want to restart page numbering: 

• If you have inserted a page break, delete the page break and replace it with a section 
break that starts on a new page. 

• On the Insert menu, click Break.  
• Under Section break types, select Next Page.  
• Start Introduction or Chapter 1 on this “next page” section. 

 
For Arabic Numbers in Text, start with cursor on the page where you want the Arabic pagination 
to start (Introduction or Chapter 1): 

• On the Insert menu, click Page Numbers.  
• Check Show Number on First Page 
• Click Format.  
• Choose Number Format:  1,2,3 
• In the Start at box, enter 1.  
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NON-PRINT MATERIALS 
 
Non-print materials, such as photographs, magnetic recordings, and electronic data files, provide 
problems for long-term storage and handling. To ensure preservation and physical stability of 
any non-print materials that accompany a thesis, or that comprise the major portion of a 
submission, observe the following guidelines. Any student with questions concerning the 
preparation of non-print material as part of an honors thesis should consult Richard Lindemann 
in Special Collections & Archives, Hawthorne-Longfellow Library at rlindema@bowdoin.edu or 
x3288. 
 
1. Regardless of the extent of non-print materials, all submissions must include paper copies of 

required forms, a title page, and other introductory materials. When the submission is non-
textual, an abstract describing the nature, scope, and content of the work is mandatory.  For 
submissions containing multiple electronic files, a printed copy of the file directory is also 
required. 

 
2. Moving images: you may submit recordings only on miniDVs or DVDs. These media should 

be of high quality, and the recordings must meet NTSC standards (foreign [non-Region 1] 
formats are not acceptable; highly compressed files are not acceptable). Please verify 
that the files you have recorded are readable on the actual recording medium that you intend 
to submit.  
 
Labeling for miniDV cassettes: adhere a label directly to the cassette with: author, title, 
length. Labeling for DVDs: insert into, or adhere onto, the case/sleeve of the disc a label 
with: author, title, file format(s), length. DO NOT affix any label, nor write or mark, directly 
on the face of the disc(s). 

 
3. Sound recordings: you may only submit recordings on “gold standard” CD-Rs. Digital sound 

files must be in WAV or AIFF format.  
Labeling for CDs: insert into, or adhere onto, the case/sleeve of the disc a label with: author, 
title, length. DO NOT affix any label, nor write or mark, directly on the face of the disc(s). 

 
4. Black-and-white images printed on thesis paper using a laser printer are acceptable. 

Photographic prints should be fiber-based, black-and-white, glossy prints; RC [resin-coated] 
papers, color prints and Polaroid photographs are impermanent and undesirable. If color 
photographic prints are essential in conveying necessary information, using special Epson 
color printers or including a duplicate black-and-white set of supplemental prints or a 
corresponding set of digital files is strongly encouraged. For further instructions about color 
photography, please see 8 below.  

 
5. An image size of approximately 5 x 7 inches allows for labeling and adequate page margins. 

Photographic prints and other similar materials should be dry-mounted on 20-pound acid-free 
paper or attached with acid-free corner mounts. Do not use rubber cement, mucilage, 
transparent tape, or other non-archival glues or adhesives; these are inherently destructive to 
paper and lose their adhering properties over time. Students who need assistance in 
determining the appropriate means for mounting illustrations may consult Carol Durak, 
Library Binding Assistant, at x3994. 
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6. Paper used for the preparation of visual materials, including photocopies when necessary, 
should be of pH-neutral or acid-free stock (see “Format Requirements for All Honors 
Projects: Acid-Free Paper” above). Photocopies should be black-and-white whenever 
possible; color photocopies are not acceptable. Images and captions or other text on pages 
that contain visual materials should conform to established margins, and such mounted sheets 
should be counted in the paging. 

 
7. All hand written labels and graphs should be in permanent ink or of permanent artist-quality 

materials; avoid color inks. Do not use felt-tip pens, color markers or pencils, which lack 
permanence. 

 
8. Because of the impermanence of color dyes and inks used in most photographic processing 

and printers, use of color images is strongly discouraged. When color images are essential, 
color slides on Kodachrome slide film provide for the best color permanence; each slide 
should be labeled with the title and the copyright statement. Alternatively, color images 
printed on an Epson 2000 series (or higher) printer, using pigment-based inks printed on 
acid-free paper, provide color stability over time and are acceptable.   Color images printed 
from digital files using other printers require the additional submission of those digital files, 
in TIFF format, on a “gold standard” CD-R.  Please see 3 above for instructions on how to 
label these discs.  

 
9. Enclosures and supports for all inserted or mounted materials should be made of pH-neutral 

paper or inert plastics. Acid-free papers and Mylar (polyester) are safe for proper archival 
storage. The College Bookstore carries Mylar supplies that are suitable for holding slides, 
photographs, etc. 

 
10. Projects involving complex electronic data sets, such as Web sites, programming codes or 

large data files, require special handling for archival preservation. Early in the planning 
process, please contact Richard Lindemann, Director of Special Collections and Archives, at 
x3288, to discuss the submission and retention of projects that include information in an 
electronic format. In some cases, it may be necessary to submit a printed copy of the project 
on acid-free paper in addition to the electronic version. When such printing is impractical, 
electronic projects must include a paper copy submission that contains required forms, a title 
page, and other introductory materials, including software specifications and an abstract 
describing the nature, scope and content of the work. 
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SUBMITTING THE HONORS PROJECT TO THE LIBRARY 
 
After your thesis is accepted by the academic department, you are required to submit your work 
personally to the Librarian of the College, Sherrie Bergman.  Deadline for submission is Friday, 
May 15, 2009 at 5:00 p.m.; this strict deadline is necessary to ensure that all honors projects are 
listed in the Commencement Program.  The title and your name must appear consistently and 
identically on all forms, the title page, and any required labeling.  Please bring a copy of the 
thesis on a memory stick so any necessary formatting corrections can be made on the spot.   
 
All approved honors projects are retained permanently in the College Archives.  The Bowdoin 
College Library is responsible for the binding, cataloging, and preservation of the official record 
copy of all Bowdoin College honors projects in the College Archives. 
 
All submissions must include: 
 

• An Honors Project Completion Form, completed and appropriately signed. 
Each honors candidate must have her or his advisor or department chair sign the attached 
Honors Project Completion Form, which is printed on acid-free paper.   

 
• An Honors Project Copying Permission Form, completed and appropriately signed. 

As the author, you hold copyright, including all rights of publication.  The Bowdoin 
College Library, as holder of the official copy of record of the project, will permit public 
access to your submission, including making a reproduction available through interlibrary 
loan.  No copies beyond one for interlibrary loan and replacement or preservation will be 
made without permission of the author.  A copying permission sheet, to help prevent 
unauthorized use of the unpublished research, must be signed by the student and 
submitted to the Library with the completed project.  A copy of the sheet, printed on acid-
free paper, is attached to this memorandum. 

 
•  

The signed completion and copying permission forms and the unbound copy of the 
completed honors project (including the required blank sheets) should be placed in an 
envelope or box adequate for packaging the submission until it is bound.  Suitable manila 
envelopes in sizes 9x12 or 10x13 inches are available at the College Bookstore.  A copy 
of the title page should be taped (transparent tape is acceptable) or glued to the outside of 
the protective envelope or box to provide temporary identification of the submitted 
package. 

 
Personal Copies 
 
Students may have personal copies of their projects bound at their own expense by contacting 
Carol Durak, Library Binding Assistant, at x3994.  Students must provide the additional copies, 
printed on paper of their choice (acid-free paper is not required for personal copies).  The cost for 
binding of personal copies is $8.00 per copy, plus $12.00 shipping and handling for up to three 
copies being mailed in the same envelope.  (Please inquire about cost for international shipping.) 
Prepayment is required by check (payable to “Bowdoin College Library”) or cash in the exact 
amount.   Please use the attached Honors Thesis Binding Order Form to place these orders.  
There is no deadline for ordering personal copies. 
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College departments may have copies of projects bound for the same costs as noted above and 
can make arrangements for departmental charge in lieu of prepayment by check. 
 
To obtain additional copies of discs, please consult Carmen Greenlee at the Language Media 
Center (x3286) before submitting the project to the Library. 
 
 
 
At graduation, bring your family and friends to the Library to see your name listed in the 

Library catalog as a published author! Good luck with your research! 
 
            2/2009 


